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Welcome…
…to this 16-page sample issue of the
AppleWorks Journal, the official news-
letter of the AppleWorks Users Group.
As you will see from this sample, every
issue of the AppleWorks Journalis
packed with tips and ideas that will
enhance your productivity with 
AppleWorks.

From the Editors
Welcome to this sample issue of the
AppleWorks Journal, the popular
AppleWorks newsletter from the Apple-
Works Users Group (AWUG). We created
this abbreviated issue because we want you to
know about AWUG, an independent association of
more than 15,000 AppleWorks users in the United
States and 51 other countries. AWUG has one goal –
to enhance your productivity with AppleWorks.

AWUG members receive these valuable services:

• Home or office delivery of a full year (ten issues) of
the AppleWorks Journal. Each 24-page issue is
filled with hints, tips, news, and ideas that will
answer your AppleWorks questions and enhance
your productivity with AppleWorks.

• Unlimited AppleWorks telephone support from
AWUG’s 76 volunteer-consultants.

• Access to AWUG’s AppleWorks support site on the
World Wide Web. This service gives you immediate
access to AWUG’s AppleWorks templates, graphics,
and utilities, and 24-hour-a-day answers to your
AppleWorks questions.

• Access to AWUG’s Public Domain Library with
more than 550 disks filled with AppleWorks tem-
plates, graphics and utility programs.

• Significant discounts on AppleWorks-compatible
products and other special offers that we negotiate
for our members.

You’ll find more information about AWUG and a spe-
cial discount membership offer in the AWUG Dis-
count file in the AWUG folder on this CD. We’re so
sure you’ll like our offerings that we maintain a “satis-
faction guaranteed or all your money back” policy for
our members.

Give us a try – it’s risk free. We hope you’ll join AWUG
and enjoy the AppleWorks Journaland all our other
valuable member services.

Greetings

from AW
UG!
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A Newsletter Assistant Tip
Dear AWUG:

I like the Newsletter Assistant that comes with
AppleWorks, but I have problems modifying the
layout. How do I remove the boxes the assistant
creates to display graphics?

Kel Griffiths
Park Ridge, South Australia

[Ed: Follow these steps to delete the placeholders
in AppleWorks’ Newsletter Assistant.

1. Use the Arrow Tool to draw a selection rectangle
around the entire frame. Press the Delete Key.
That will delete the two lines within the frame.

2. Click on the rectangle you want to delete.

3. Select “Unlock” from the Arrange Menu.

4. Press the Delete Key.

The process is more complex than we’d like, but
Apple had to lock the frames to keep users from
accidentally deleting them. Once you do it a few
times, the steps become automatic. You can even
create an AppleWorks macro to delete the frames.

For more help using AppleWorks’ Newsletter
Assistant, see the article entitled “How to Use
AppleWorks’ Newsletter Assistant” in the April
1995 issue of the AppleWorks Journal.] ■
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More Powerful Searching

Dear AWUG:

I need some help using the AppleWorks database I
created to store my grandmother’s recipes. It’s a
simple database with three fields: Recipe Name,
Ingredients, and Instructions (see Figure 1). Now I
want to search for specific combinations of ingre-
dients in my recipes. For example, I want to find
all recipes that include “chicken” and“onion” and
“sour cream”.

I figured out how to find all the records that con-
tain “chicken”. But every time I search for
“onion”, AppleWorks ignores my earlier “chicken”
search and gives me every recipe that contains
“onion”...even if it doesn’t contain “chicken”.

How can I search for these combinations in 
AppleWorks?

Mike Greene
Alexandria, Virginia

[Ed: If you are comfortable writing formulas,
AppleWorks’ Match Record command can do the
selection for you. But I prefer to use AppleWorks’
Find Record command to select the records. Fol-
low these steps:

1. Press Shift- -F to display the Find Records
screen. Then click in the field you are using to
select the records you want (in this case, the
Ingredients field). Then enter the first word
you’re hunting for. (For example, click in the
Ingredients field and type “chicken”. Your
screen should look like Figure 1.) Then click on
the “Find” button.

2. Once again, press Shift- -F. Click in the
Ingredients field and type “onion”. Then click
on the “Find from Visible” button before click-
ing on “Find” (see Figure 1). That tells Apple-
Works to limit your search to the records you
selected earlier.

3. Repeat step #2 and enter “sour cream”. The
selected records will all contain “chicken”,
“onion”, and “sour cream”.

When you’re done, press Shift- -A to display all
the recipes.]

Letters to AWUG
TM

Windows

Figure 1: Selecting “Find from Visible”

Click here to
limit your

search.
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Turn back the clock for a moment –
back to the days of journeymen and
apprentices. It’s easy to picture an

apprentice watching the journeyman and
trying each new technique demonstrated
by the master.

With time, the apprentice becomes a mas-
ter himself, embellishes what he learned
from his teacher, and passes his knowledge
to the next generation of artisans.

So it should be with AppleWorks. Spend
a few minutes with a master and you will
learn more about the program than you
can from the best of books. Ask ques-
tions. Probe. Stop his work in mid-
stream. And be prepared to remember all
the techniques before you.

That is how we prepared this article. We
watched, asked, and probed AWUG’s
experts looking for the most useful
AppleWorks tips. Here are the ten most interesting
tips we encountered in our explorations.

I. Create your own default settings.

AppleWorks gives you complete control over the
default fonts, margin settings, and other options
that appear when you create a new document. But
the procedure you follow to define your defaults is
not intuitive.

The trick is to create AppleWorks stationery docu-

ments that contain your preferences. You create a
separate stationery document for each AppleWorks
environment. Then you save the documents in
files named “AppleWorks xx Options”; Apple-
Works will use those files as the basis for every new
document you create.

The letters that replace the “xx” in the file name
tell AppleWorks which file to use. For example, the
file “AppleWorks WP Options” contains the default
settings for all new word processor documents.
“DB” defines the database defaults, “SS” controls
your spreadsheets, “DR” defines the drawing docu-
ment defaults, “PT” is for painting, and “CM” for
communications. You then store the default files in
the Stationery folder within the AppleWorks folder.

Try it. Follow these steps:

1. Create a new word processor document.

2. Switch to the font and size you want to use in
your future documents.
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General Interest

AWUG’s Top Ten AppleWorks Tips
by Warren Williams and Cathleen Merritt

Dr. Warren Williams, the President of AWUG and
Editor of the AppleWorks Journal,is a Professor
Emeritus of Educational Technology at Eastern
Michigan University. 

Cathleen Merritt, Director of AWUG and Associ-
ate Editor of the AppleWorks Journal, has pub-
lished more than 300 articles in computer and
technology magazines and newsletters.

Figure 1: Simultaneous Layout and Browse Views

Windows
TM



3. Change the margin and/or tab settings to your
new defaults.

4. Save the file as an AppleWorks Stationery docu-
ment named “AppleWorks WP Options” in the
Stationery folder within your AppleWorks
folder.

5. Close the document. Respond “No” to the “Do
you want to save your changes?” prompt.

Now you will test your template. Create a new
word processor document and type a few charac-
ters. AppleWorks should use the font you used in
your “AppleWorks WP Options” document. 

II. Create two views of your database documents.

Changing a database layout requires you to switch
between Layout mode (where you change the lay-
out) and Browse mode (where you see the effects
of your changes). Repeatedly switching between
Layout and Browse modes can be tedious. 

To increase your efficiency, create two views of the
same data. Then you can display your document in
both modes simultaneously and immediately see
your changes on the screen (see Figure 1).

Follow these steps to create separate Layout and
Browse views of a database file:

AppleWorks Journal
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1. Display the database in Browse mode.

2. Choose “New View” from the View Menu.
AppleWorks will open a second window
with the same view of your document.

3. Choose “Layout” from the Layout Menu to
change the new view to Layout mode.

4. Choose “Tile Windows” from the View or
Window Menu. AppleWorks will arrange
the windows so you can see both views on
the screen. Any changes you make in Lay-
out mode will immediately appear in the
Browse mode view.

III. Use the -(minus) keystroke to save
time entering database data.

Pressing -(minus) enters the current date,
time, or record number in date, time, and num-
ber fields respectively. That makes it easy to

enter dates and times in your database records.
(Windows users: Press Control-minus to enter the
date or time. A complete table of Windows key-
stroke equivalents appears on page 10.)

IV. Use AppleWorks’ Table Assistant to create
your tables and charts.

AppleWorks’ word processor environment provides
tabbing tools that you can use to create tables and
charts. But AppleWorks’ Table Assistant makes it
even easier to create lists and tables in your docu-
ments. For example, examine Figure 2,which
depicts a word processor document that contains a
spreadsheet-based table with the formatted data.
You can then use AppleWorks’ charting capa-
bilities to create graphs for your documents.

Try it. Create a word processor document and then
launch the assistant from the Help Menu or from
the Balloon Help icon in the top right-hand cor-
ner of your screen.

V. Use the “Copy Table” Command.

AppleWorks for Macintosh’s communications envi-
ronment offers a Copy Table Command that auto-
matically copies and pastes tables from a communi-
cations document into a spreadsheet. That makes it
easy to copy financial information and other tabu-

Figure 2: Using a Spreadsheet to Create a Table
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General Interest

lar data received from your on-line service
into any AppleWorks document.

Follow these steps to copy tabular data
captured from a bulletin board service
into a spreadsheet:

1. Click and drag to highlight the infor-
mation in the communications docu-
ment on your screen.

2. Choose “Copy Table” from the Edit
Menu.

3. Create a new spreadsheet or switch to
an existing spreadsheet template.

4. Click in the cell where you want the
first piece of tabular data to appear.

5. Choose “Paste” from the Edit Menu.
AppleWorks will paste each piece of
data into a separate cell.

VI. Use AppleWorks’ BEEP and
ALERT functions to improve your
spreadsheets and databases.

AppleWorks’ BEEP and ALERT func-
tions let you warn users of mistakes they
make when using an AppleWorks spread-
sheet or database template.

BEEP sounds the system beep; ALERT
sounds the beep and displays an alert 
box with the message you specify (see
Figure 3).

For example, the formula 

=IF(A10<0, ALERT("Illegal negative value in Cell
A10"),A3*A10)

displays a warning message if cell A10 contains a
negative number. Otherwise, this formula displays
the product of cells A3 and A10. 

VII. Use AppleWorks’ Lock Titles Option to
lock titles on your spreadsheet screen.

AppleWorks lets you lock the top rows and the
left-hand columns of your spreadsheet templates as
“titles” on the screen. The titles stay on the screen
when you scroll around a large worksheet; that
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makes it easier to read the column and row head-
ings in your template.

To lock the titles, put the cursor on the cell that
defines the lowest row and right-most column that
contains the titles. Then select “Lock Title Posi-
tion” from AppleWorks’ Options Menu. For exam-
ple, examine Figure 4, where the first 13 rows
contain locked titles. These rows remain on the
screen even as you scroll down the spreadsheet.
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Figure 3: Warning Message Generated by the ALERT Function
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Figure 4: Spreadsheet with Titles
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You cannot edit locked titles. To unlock the titles,
re-select “Lock Title Position” from the Options
Menu. 

VIII. Use the NOW function to enter the cur-
rent date or time in a spreadsheet cell or a
database record.

AppleWorks’ NOW function displays the current
date or time in a spreadsheet cell or database
record.

In a spreadsheet, enter =NOW( ) as the formula
and set the number format of the cell to display a
date or time. In the database environment, define
the field as a calculated field, enter the formula
NOW( ), and select “Date” or “Time” from the
“Format result as...” pull-down menu.

IX. Use text and graphic frames for your notes.

AppleWorks lets you create text and graphic frames
to present instructions and notes. For example,
examine Figure 5 which uses a graphic frame in a
spreadsheet to display instructions for the template.

To annotate a cell, select the Text Tool and click
and drag to create a text frame next to the infor-
mation you want to annotate. Then enter the text

you want in the note. You can leave the text
frame selected when you save your template
and tell the readers to delete the frame by
pressing the Delete Key after they read the
note.

You can also use AppleWorks’ graphic tools to
create an attractive border around the message
like the example in Figure 5. Follow these
steps:

1. Select the Rectangle Tool. Then click 
and drag in the spreadsheet to create a
rectangle. Drag the rectangle into its final
position in the spreadsheet.

2. Select a fill pattern from the Fill Palette.

3. Select the Text Tool and click within the
rectangle.

4. Select a font, font style, and font size from
the Font, Size, and Style Menus. Then type
the text you want in your label. 

5. Select the Arrow Tool. Then click once on the
text and re-size and re-position the text block
within the graphic.

X. Use the tear-off fill and pen tool palettes.

AppleWorks offers “tear-off” fill and pen tool
palettes that you can put anywhere on your screen.
To save time and effort, put the palettes next to
the objects you are creating or modifying. The
torn-off palettes remain open until you click on
their Close Boxes.

To tear off a palette, click on the tool to open the
palette and drag to the right until the palette
moves away from the left edge of the screen. 

Conclusion

These are just ten of the dozens of tips and sugges-
tions we receive from our AWUG colleagues. Col-
lecting and sharing your ideas is one of our most
important jobs; please send your AppleWorks tips
to “My Favorite Tip”, AWUG, Box 701010, Ply-
mouth, Michigan 48170 or email your ideas and
suggestions to <editor@awug.org> or fax them to
AWUG at (734) 454-1965. ■

Figure 5: Using Text and Graphics Frames



Growing numbers of small business owners
use AppleWorks to prepare their correspon-
dence and manage their finances. And

many users are discovering that AppleWorks is also
flexible and powerful enough to handle their com-
pany’s advertising and promotions.

Brochures are a perfect way to promote your busi-
ness; a well-designed brochure can evoke a gratify-
ing response from existing and potential customers.
You can display your brochure at the front desk or
checkout counter, or you can create a brochure
that you mail to customers. Either way, a tri-fold
flyer provides an opportunity to highlight your
company’s products or services.

This article describes how to create an AppleWorks
template you can customize to create your own
two-sided, tri-fold brochure like the example in
Figure 1.

Since there are as many brochure styles as there
are AppleWorks users, you should feel free to copy
or “tweak” this layout to suit your taste. The infor-
mal look I chose is appropriate for a fictitious lawn
service such as Keep It Green, but my design is
equally at home in a consignment shop or bed and
breakfast inn. By contrast, a law office might want
to project a more formal image.

The paper you use can enhance your message, so
you should choose your paper carefully. Solid color
paper is a low-cost alternative, but designer papers
like those offered by the suppliers listed in the
“Colorful Options” sidebar can make your cus-
tomers sit up and take notice. And that is what
this template is all about.

Creating the Brochure Template

Follow these steps to create your own tri-fold
brochure:

AppleWorks Journal

1. Launch AppleWorks and begin a new drawing
document.

2. Choose “Page Setup” or “Print Setup” from the
File Menu and select the landscape page orien-
tation.

3. Select “Page View” from the Window Menu for
a more WYSIWYG (what you see is what you
get) look at your work-in-progress.

4. Choose “Document” from the Format Menu
and set all the margins to zero inches. (All
measurements in this template are in inches.)
That lets you divide each page into three bal-
anced columns. Set “Pages Across” to “2” and
click on “OK”.

5. Select “Rulers” from the Format Menu, click on
the Graphics Button, and set the ruler divisions
to “16”. Although AppleWorks will divide the
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rulers on the screen into eighth-inch increments,
AppleWorks’ Autogrid feature will accommodate
precision to one-sixteenth-of-an-inch when you
lay out your brochure. Then click on “OK”.

Now you will draw vertical lines to serve as guides
for the layout on each page. The settings I suggest
leave room for the folds between the pages. Con-
tinue as follows:

AppleWorks Journal
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6. Double-click on the line tool to
“permanently” select that tool.
(Double-clicking on the tool lets
you create all four lines without
jumping back to the Tool Palette.
Clicking on any other tool turns
off the line tool selection.)

7. Draw lines down the page starting
at the following points on the
ruler at the top of the screen:

• 3 5/8-inches
• 7 5/16-inches
• 14 11/16-inches
• 18 3/8-inches

To draw straight lines, click on the
starting point of the line, then hold down the Shift
Key to “constrain” AppleWorks while you draw the
line. (“Constraining” makes the line perfectly
straight.)

8. Press -A to select all the lines and -G to
group them as a unit. Grouping the lines makes
it easier to delete them before you print your
finished brochure. Click anywhere on the page
to de-select the temporary guides.

9. Select “Frame Links” from the Options Menu.
This displays the text frames you will create in
the next step and will make it easier to select
the correct frame.

Now you will draw the text frames for your tem-
plate. Continue as follows:

10.Double-click on the text tool and draw the fol-
lowing text frames. Begin each frame one-half
inch from the top of the appropriate page and
end each frame at the 8-inch mark near the
bottom.

Left Edge Right Edge
Text Frame Begins at: Ends at:

Panel 1 .1/4 3.1/2
Panel 2 3 3/4 7.3/16
Panel 3 7.7/16 10.3/4
Panel 4 11.1/4 14.9/16
Panel 5 14.13/16 18.1/4
Panel 6 18.1/2 21.3/4

Figure 2: Brochure with Text Frames
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Colorful Options
Here are five sources of attractive colored papers that
can enhance your flyers. Call the companies’ toll-free
numbers to request free, full-color catalogs. Designer
paper is pricey but, to paraphrase an old saying, “Using
the best paper for your brochure doesn’t cost, it pays.”

IdeaArt
P. O. Box 291505
Nashville, TN 37229
(800) 433-2278 (voice/fax)
<www.ideaart.com>

Paper Access
23 West 18th Street
New York, NY 10011
(800) PAPER-01
(212) 924-7318 (fax)
<www.paperaccess.com>

PaperDirect
205 Chubb Avenue
Lyndhurst, NJ 07071
(800) 443-2973
(201) 271-9601 (fax)
<www.paperdirect.com>

Queblo
P. O. Box 8465
Mankato, MN 56001
(800) 523-9080
(800) 842-3371 (fax)
<www.papershowcase.com>

Quill
100 South Shelter Rd.
Lincolnshire, IL  60069
(800) 789-0057
(800) 789-8955 (fax)
<www.quillcorp.com>
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Figure 3A: Page One of Brochure

Figure 3B: Page Two of Brochure
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— Spring —

• Get a head start on a green lawn with our early
fertilizer application.  It gives your yard a
strong beginning and helps build a good root
system.

• We repair any damage from the previous win-
ter. Your yard will be ready to display with
pride.

• We provide you with a never-ending series of
bright flowering plants. We unobtrusively
maintain and replace flowers. You’re guaran-
teed constant color to highlight your buildings.

• Raking, hoeing, seeding, sodding – no matter
what your lawn needs to make it healthy, we
do it all.

— Summer —

• Our feeding program keeps your lawn looking
healthy all summer long.

• We keep your lawn free of weeds. Your yard
will remain smooth and emerald green
throughout the season.

• Summer storms can wreak havoc with your
yard. Our maintenance crew prunes damaged
trees and removes fallen branches.

• Bug, bugs, bugs! Summer is full of them. From
giant caterpillars to gypsy moths, we help you
keep ahead of them.

— Fall —

• Fall is the time to get your lawn ready for the
next summer. We feed, de-thatch, and mulch
your lawn to keep it looking its best next year.

• The beautifully colored leaves of autumn are
wonderful...until they fall off the trees. But with
Keep It Green, there’s no hassle. We rake, bag,
and remove the leaves before you even realize
they’ve fallen.

• Plants which bloom beautifully all spring and
summer can’t always survive winter on their
own. We protect your plants to help ensure they
look just as lovely next spring as they do now.

— Winter —

• Winter brings its own problems. Among other
services which we provide, we shovel snow
before your business opens for the day.

• Winter storms with their ice and heavy snow
can harm your trees. We take care of damaged
trees and remove fallen branches.

• We use salt and gravel to make sidewalks safe,
no matter how harsh the weather.

with

Keep It Green

you can have
…a beautiful yard…

without lifting a finger
or 

straining your budget

n Yes! I want a FREE appraisal. Please
contact me to arrange an appointment.

__________________________________
Name

__________________________________
Address

__________________________________

__________________________________
City, State, Zip Code

__________________________________
Telephone

Keep It Green
Four seasons yard care
1234 S. Maple
Calumet, MI  49913
(906) 555-1212

Section headers are set in Optima, 12 point, Bold, centered. Press Shift-Option-
hyphen to type the em dashes. The body text is Palatino, 10 point. The bullets are
produced by pressing Option-8 followed by a tab.

Create the check box by typing
“n” in Zapf Dingbats, Outline.
Windows users: Type “q” in the
Wingdings font.

Produce the “underline” by pressing
Shift-- repeatedly.  The fine print
below the line is 7 point Palatino.
Make the entire line (including the
Return) 7 point to ensure that the
spacing is correct.

“Keep it Green” is set in Palatino, 22 point, Bold
Italic. The address is set in Palatino, 12 point.
Then rotate the text block 90° counter-clockwise.

Optima, Bold
36 point, centered.

“Falling Leaves” EPS format clip
art, available on AWUG’s Graph-
ics Primer Disk.

Optima, Bold
36 point, centered.

To make this line appear bal-
anced, type “…Lawn…”, select
the first ellipsis (…), and change
the text color to white. 

Palatino, 14 point, Bold, centered.

Optima, 14 point, centered.
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Your layout should look like the example in
Figure 2.

11.Follow these steps to add your return address to
the mailing panel:

A. Select the text tool and draw a small text
frame in the middle panel of the first page.

B. Type and format your return address infor-
mation.

C. Click on the the arrow tool and select the
text frame. Then choose “Rotate” from the
Arrange Menu and enter “90” in the Rotate
dialog.

12.Save your template in an AppleWorks stationery
file named “Brochure Template”. Then close
the document.

Using the Template

Follow these steps to use the template:

1. Open the stationery template to create a new
document and create a brochure to suit your
needs. The possibilities are beyond the scope of
this article, but you can can get some ideas
from the example in Figures 3A and 3B.

2. When you are done, select one of the tempo-
rary guides and press -X to delete all four
lines. Then save your design.

Now you will print the brochure. Continue as fol-
lows:

3. If you use a LaserWriter, select “Page Setup”
from the File Menu and choose “Larger Print
Area (fewer downloadable fonts)” from the
LaserWriter Setup Menu.

4. Select “Print” from the File Menu (or press 
-P). AppleWorks will warn you that the doc-

ument’s margins are too small and may cause
the printout to be clipped. Ignore the warning
by clicking on “OK”. Then print your work.

5. Examine the edges of each page carefully for
missing text or graphics. See the sidebar enti-
tled “How to Handle Printing Problems” if your
output is not acceptable.

Conclusion

As you can see, it is easy to prepare your own tri-
fold brochures with AppleWorks. Simply print a
master copy and then take it to a local quick
printer for double-sided copying. Fold the
brochures, attach mailing labels, and send your
promotional piece on its way. ■

How to Handle Printing Problems

Some printers do not print closer than .42 inches
from the edge of the page. If your printer clips the
edges of your document, use the following margins
in step #10:

Left Edge Right Edge
Text Frame Begins at: Ends at:

Panel 1 .1/2 3.1/2
Panel 2 3.7/8 7.3/16
Panel 3 7.9/16 10.1/2
Panel 4 11.1/2 14.1/2
Panel 5 14.7/8 18.3/16
Panel 6 18.9/16 21.1/2

Keyboard Reminders

AWUG uses Macintosh keyboard conventions in the
AppleWorks Journal. Windows users should substi-
tute the following keystrokes when completing the
tutorials in each issue:

Mac Windows

Press the Control Key (or Ctrl Key). For
example, press Control-S when an author
says “Press -S”.

Option Press and hold down the Alt Key when an
author tells you to use the Option Key.

Return Press the Return, Enter, or ↵ key on the
keyboard when asked to “Press the Return
Key”. (Windows keyboards label this key
differently.) Do not press the Enter Key on
the numeric keypad unless specifically
instructed to do so.

Windows
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Database Primer

This article describes how to create and
print database reports. You will need the
coin collection database included in the
AWUG Productivity Pack folder on this CD-
ROM.

Much of your work with database files
can be classified as “overhead”;
operations you must perform if you

want to store your data on a computer. Nec-
essary “overhead” includes creating the
database and entering and maintaining your
data. Of course, all that work pays off when
you view or print your records.

AppleWorks gives you three ways to use
your data: (1) You can view the contents of
one or more records on your screen, (2) You can
use the program’s mail merge capability to com-
bine information from your database into any
string of text, and (3) You can print reports that
list or summarize the information in your file.

This article describes the reporting process. By the
time you complete this tutorial, you will be able to
create and print AppleWorks database reports.

You need a database for this project. Rather than
having you create one from scratch, I created the
file for you. It’s the Coin Collection database in
the AWUG Productivity Pack folder on this CD-
ROM. [Ed: The author selected a coin collection
example because it requires calculated and sum-
mary fields. That will help you develop the skills
you need to work with different types of database
files.] Your final report will list the contents of
each coin collection case (see Figure 1).

Four Stages

Producing a report is a four stage process:

Stage I: Create a layout.

Stage II: Select the records for the report.

Stage III: Sort the data.

Stage IV: Save the report.

It’s easy to remember the sequence of these opera-
tions because they follow the order of the four but-
tons on AppleWorks’ database Tool Palette (see
Figure 2).

This tutorial will take you step-by-step through the
reporting process. I suggest that you launch Apple-

How to Create Your First Database Report
by Keith Bernhard

Figure 1: Coin Case Directory Report 

?
?

?W2@@6X?g?@@?he?W2@@6X? @@@@he?W2@@6X?g?@@?he@@@@@@ @@e@@ ?@@?@@f@@?@@?g?@@?hfW2@@6X ?@@?@@?@@??@@? W2@@6X @@ ?
W&(MI4)? W&(MI4)? @@@@heW&(MI4)? @@ 3@e@5 ?@@?@@L??J@@he?@@Lhe?W&(MI4) ?@@?e?@@L ?W&(MI4) @@L? ?
7@H?f?W2@6X?@@?@@@@6Xf7@H?fW2@6X?W2@6X??W2@6Xf@@@@@5he7@H?f?W2@6X?@@?@@@@6Xg@@e?@@??@@?@@@6X??W2@6X N@@@@HeW2@6X?W2@6X?@@@(?@@?@@1??7@@?@@?@@@@6X?@@@he?7@HgW2@6X?@@@@6XeW2@@@?@@?@@@?@@??W2@6X?@@@@6X? ?7@HgW2@6X??@@?@@?@@@@6X?@@@? ?
@@g?7@?@1?@@?@@(Y@1f@@g*@?@1?*@?@)??7@?@1fN@@@@Hhe@@g?7@?@1?@@?@@(Y@1g@@e?3@??@5?@@?@1??7@?@1 ?3@@5?e7@?@1?*@?@1?@@(YJ@5?@@@??@@@?@@?@@(Y@1?@@Hhe?@@?g7@?@1?@@(Y@1e7@?@@?@@?@@H?@@??7@?@1?@@(Y@1? ?@@?g7@?@1??@@?@@?@@(Y@1?@@H? ?
@@g?@@?@@?@@?@@H?@@f@@g?@@@@?V4@@e?@@@@@fJ@@@@Lhe@@g?@@?@@?@@?@@H?@@g@@e?N@@@@H?@@?@@??@@@@@ ?N@@H?e@@@@@??@@@@?@@H?7@H?@@@@@@@@?@@?@@H?@@?@@?he?@@?g@@?@@?@@H?@@e@@?@@?@@?@@??@@??@@?@@?@@H?@@? ?@@?g@@?@@??@@?@@?@@H?@@?@@ ?
3@L?f?@@?@@?@@?@@e@@f3@L?f7@?@@?e?@1??@@?g7@@@@@he3@L?f?@@?@@?@@?@@e@@g@@f3@@5e@@?@@??@@? @@f@@f7@?@@?@@e@@e@@@@@@@@?@@?@@e@@?@@?he?3@Lg@@?@@?@@e@@e@@?@@?@@?@@??@@??@@?@@?@@??@@? ?3@Lg@@?@@??@@?@@?@@??@@?@@ ?
V')KO2(??3@?@5?@@?@@e@@fV')KO2(?3@?@@W26X@5??3@W2(f@@@@hfV')KO2(??3@?@5?@@?@@e@@g@@fN@@He@@?@5??3@W2( @@f3@W2(?3@?@@?@@e@@e@@?@@?@@?@@?@@e@@?3@Lhe?V')KO2(e3@?@5?@@e@@e3@?@@?@@?3@L?@@??3@?@5?@@??@@? ?V')KO2(e3@?@5??3@@@@?@@??@@?3@L? ?
?V4@@0Y??V4@0Y?@@?@@e@@f?V4@@0Y?V4@@@0R4@0Y??V4@0Yf@@@@hf?V4@@0Y??V4@0Y?@@?@@e@@g@@fJ@5?e@@@0Y??V4@0Y @@fV4@0Y?V4@@@@@@e@@e@@?@@?@@?@@?@@e@@?V4@hfV4@@0YeV4@0Y?@@e@@eV4@@@?@@?V4@?@@??V4@0Y?@@??@@? V4@@0YeV4@0Y??V4@@@?@@??@@?V4@? ?

7@H?e@@ ?
@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@?h@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@?@@?@@?@@?@@@@@@@@@@? @@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@?h?@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@ ?@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@ ?

?
?
?
?
?
?
?
?

?W2@6XfW&h@? ?@@@@6X? @?f?@ @?he?@f?@ @? W&fW2@6X??W2@6Xe?W&? @@@@@??@ ?W&? ?
?7<?B1e?W&@h@? ?@e?B1? @? @?he?@f?@ @? ?W&@f7<?B1??.M?B1eW&@? @? W&@? ?
?@e?@eW.Y@g?J@L ?@f@??W26X?e)T26X??)T26X?@e?@h@?f?@e)T26X??W26X??W26X?e@??)T26Xf?@f?@eW26XeW2@6X?eW26X@? ?.Y@f@?e@?f?@e.Y@? @?f?@e)T26X??W26X? .Y@? ?
?@e?@?W.Y?@g?7R1 ?@f@?W.MI/Xe@(MB1??@(MB1?@e?@h@?f?@e@(MB1?W.MI/?W.MI/Xe@??@(MB1f?@f?@?W.MI/X?.M?S1??W.MI'@? ?@f@?e@?fJ5f@? @?f?@e@(MB1?W.MI/X @? ?
?@e?@?7Y??@L?fJ5?3L? ?@e?C5?7YeV1e@He@??@H??@?3L?J5h@?f?@e@He@?7Hf7HeN1e@??@H??@f?@@@@@@@?7Y??V1?eO&@??7H??N@? ?@f3=e@?e?W.Yf@? @@@@@??@e@He@?7YeV1 @? ?
?@e?@?@@@@@@?f7Y?V1? ?@@@@0Y?@@@@@@e@?e@??@e?@?N1?7Hh@?f?@e@?e@?@?f@?e?@e@??@e?@f?@f?@?@@@@@@?W20Y@??@f@? ?@fV4@@@?eW.Y?f@? @?f?@e@?e@?@@@@@@ @? ?
?@e?@f?@H?e?J@@@@@L ?@g3Xg@?e@??@e?@e3T5?h@?f?@e@?e@?3Lf3LeJ5e@??@e?@f?@f?@?3X?f7<?J@??3L??J@? ?@h@??W.Yg@? @?f?@e@?e@?3X @? ?
?3=?C5f?@f?7<?eB1 ?@gV/KO.?e@?e@??@e?@eN@H?h@?f?@e@?e@?V/KO.?V/KO.Ye@??@e?@f?@f?@?V/KO.e3=O&@L?V/KO&@? ?@f/K?C5??7Y?g@? @?f?@e@?e@?V/KO.? @? ?
?V4@0Yf?@f?@f?@ ?@g?V40Y?e@?e@??@e?@eJ5f@?f@@@@@??@e@?e@??V40Y??V40Y?e@??@e?@f?@f?@eV40YeV40MI/eV40R'? ?@fV4@0Y??@@@@@f@? @?f?@e@?e@??V40Y? @? ?

7He?J5? ?
?J5?e?.Y? ?
?.Y? ?

?
?
?
?
?
?
?
?
?
?

?W2@6XfW&h@? ?@@@@6X? @?f?@ @?he?@f?@ @? W&fW2@6X??W2@6XeW2@6X?fW2@@6X W2@@6X ?@ ?W&? ?
?7<?B1e?W&@h@? ?@e?B1? @? @?he?@f?@ @? ?W&@f7<?B1??.M?B1e.M?B1?f7<eI/ ?W.MeI/X? ?@ W&@? ?
?@e?@eW.Y@g?J@L ?@f@??W26X?e)T26X??)T26X?@e?@h@?f?@e)T26X??W26X??W26X?e@??)T26Xf?@f?@eW26XeW2@6X?eW26X@? ?.Y@f@?e@?f?@g@?f3= ?7H?e?V/??W26X?eW26Xe?W26X@ .Y@? ?
?@e?@?W.Y?@g?7R1 ?@f@?W.MI/Xe@(MB1??@(MB1?@e?@h@?f?@e@(MB1?W.MI/?W.MI/Xe@??@(MB1f?@f?@?W.MI/X?.M?S1??W.MI'@? ?@f@?e@?fJ5f?C5?fV46K ?@hW.MI/X?W.MI/X?W.MI'@ @? ?
?@e?@?7Y??@L?fJ5?3L? ?@e?C5?7YeV1e@He@??@H??@?3L?J5h@?f?@e@He@?7Hf7HeN1e@??@H??@f?@@@@@@@?7Y??V1?eO&@??7H??N@? ?@f3=e@?e?W.Yf@@U?gI46X ?@f@@@?7HeN1?7H??N1?7HeN@ @? ?
?@e?@?@@@@@@?f7Y?V1? ?@@@@0Y?@@@@@@e@?e@??@e?@?N1?7Hh@?f?@e@?e@?@?f@?e?@e@??@e?@f?@f?@?@@@@@@?W20Y@??@f@? ?@fV4@@@?eW.Y?f?B1?hB1 ?@g@?@?e?@?@f@?@?e?@ @? ?
?@e?@f?@H?e?J@@@@@L ?@g3Xg@?e@??@e?@e3T5?h@?f?@e@?e@?3Lf3LeJ5e@??@e?@f?@f?@?3X?f7<?J@??3L??J@? ?@h@??W.Yh@?h?@ ?3L?e?J@?3LeJ5?3L??J5?3LeJ@ @? ?
?3=?C5f?@f?7<?eB1 ?@gV/KO.?e@?e@??@e?@eN@H?h@?f?@e@?e@?V/KO.?V/KO.Ye@??@e?@f?@f?@?V/KO.e3=O&@L?V/KO&@? ?@f/K?C5??7Y?f/K?C5?f/KeC5 ?V/KeO&@?V/KO.Y?V/KO.Y?V/KO&@ @? ?
?V4@0Yf?@f?@f?@ ?@g?V40Y?e@?e@??@e?@eJ5f@?f@@@@@??@e@?e@??V40Y??V40Y?e@??@e?@f?@f?@eV40YeV40MI/eV40R'? ?@fV4@0Y??@@@@@eV4@0Y?fV4@@0Y V4@@0R'??V40Y?eV40Ye?V40R' @? ?

7He?J5? ?
?J5?e?.Y? ?
?.Y? ?

?
?
?
?
?
?
?
?
?

?W2@@6X? ?
?@@@@@@?g?@@?g?@@?fW2@@6X @@he?&0M?@1? ?
?@@?h?@@Lg?@@?e?W&(MI4) @@L?hf?@@? ?
?@@?e?W2@6X?@@@?W2@6X?@@?e?7@HgW2@6X??@@?@@?@@@@6X?@@@?hfJ@5? ?
?@@?e?7@?@1?@@H?&@?@1?@@?e?@@?g7@?@1??@@?@@?@@(Y@1?@@H?he?W&(Y? ?
?@@?e?@@?@@?@@?e@@@@?@@?e?@@?g@@?@@??@@?@@?@@H?@@?@@hfW&(Y ?
?@@?e?@@?@@?@@??7@?@@?@@?e?3@Lg@@?@@??@@?@@?@@??@@?@@he?W&(Y? ?
?@@?e?3@?@5?3@L?3@?@@?@@?e?V')KO2(e3@?@5??3@@@@?@@??@@?3@L?h?7@Y ?
?@@?e?V4@0Y?V4@?V4@@@@@@?fV4@@0YeV4@0Y??V4@@@?@@??@@?V4@?h?@@@@@@? ?

?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?

W&fW2@6X?f@@@@6X ?@f?@e@?g@?hf@?g?@hf?@e@? @?f@? ?@ W&fW2@6X??W2@6Xe?W&? @@@@@??@ ?W&? ?
?W&@f.M?B1?f@?eB1 ?@L?e?@he@?hf@?g?@hf?@ @?f@? ?@ ?W&@f7<?B1??.M?B1eW&@? @? W&@? ?
?.Y@h@?f@?e?@ ?@)Xe?@e@??W26X?@??W.??W26X?e@?g?@e)T26X??W26X@e@?W2@6X?e)T26X?f@?f@??W26X??W2@6Xe?W26X@ ?.Y@f@?e@?f?@e.Y@? @?f?@e)T26X??W26X? .Y@? ?
?@g?J5?f@?eC5 ?@V/X??@e@?W.MI/?@?W.Y?W.MI/Xe@?g?@e@(MB1?W.MI'@e@?.M?S1?e@(MB1?f@?f@?W.MI/X?.M?S1eW.MI'@ ?@f@?e@?fJ5f@? @?f?@e@(MB1?W.MI/X @? ?
?@gW.Y?f@@@@@U ?@?V/X?@e@?7Hf@W.Ye7YeV1e@?g?@e@He@?7HeN@e@?eO&@?e@He@?f@@@@@@@?7YeV1e?O&@e7HeN@ ?@f3=e@?e?W.Yf@? @@@@@??@e@He@?7YeV1 @? ?
?@f?W.Yg@?eB1 ?@eV/X@e@?@?f@@U?e@@@@@@e@?g?@e@?e@?@?e?@e@?W20Y@?e@?e@?f@?f@?@@@@@@?W20Y@e@?e?@ ?@fV4@@@?eW.Y?f@? @?f?@e@?e@?@@@@@@ @? ?
?@fW.Y?g@?e?@ ?@e?V'@e@?3Lf@V/Xe3Xg@?g?@e@?e@?3LeJ@e@?7<?J@?e@?e@?f@?f@?3Xf?7<?J@e3LeJ@ ?@h@??W.Yg@? @?f?@e@?e@?3X @? ?
?@f7Yh@?eC5 ?@fN@e@?V/KO.?@?V/X?V/KO.?e@?g?@e@?e@?V/KO&@e@?3=O&@Le@?e@?f@?f@?V/KO.??3=O&@L?V/KO&@ ?@f/K?C5??7Y?g@? @?f?@e@?e@?V/KO.? @? ?
?@f@@@@@?f@@@@0Y ?@f?@e@??V40Y?@??V/??V40Y?e@??@f?@e@?e@??V40R'e@?V40MI/e@?e@?f@?f@??V40Y??V40MI/??V40R' ?@fV4@0Y??@@@@@f@? @?f?@e@?e@??V40Y? @? ?

J5 ?
.Y ?

?
?
?
?
?
?
?
?
?
?
?

W&fW2@6X?f@@@@6X ?@f?@e@?g@?hf@?g?@hf?@e@? @?f@? ?@ W&fW2@6X??W2@6XeW2@6X?fW2@@6X @@@@@??@ ?W&? ?
?W&@f.M?B1?f@?eB1 ?@L?e?@he@?hf@?g?@hf?@ @?f@? ?@ ?W&@f7<?B1??.M?B1e.M?B1?f7<eI/ @? W&@? ?
?.Y@h@?f@?e?@ ?@)Xe?@e@??W26X?@??W.??W26X?e@?g?@e)T26X??W26X@e@?W2@6X?e)T26X?f@?f@??W26X??W2@6Xe?W26X@ ?.Y@f@?e@?f?@g@?f3= @?f?@e)T26X??W26X? .Y@? ?
?@g?J5?f@?eC5 ?@V/X??@e@?W.MI/?@?W.Y?W.MI/Xe@?g?@e@(MB1?W.MI'@e@?.M?S1?e@(MB1?f@?f@?W.MI/X?.M?S1eW.MI'@ ?@f@?e@?fJ5f?C5?fV46K @?f?@e@(MB1?W.MI/X @? ?
?@gW.Y?f@@@@@U ?@?V/X?@e@?7Hf@W.Ye7YeV1e@?g?@e@He@?7HeN@e@?eO&@?e@He@?f@@@@@@@?7YeV1e?O&@e7HeN@ ?@f3=e@?e?W.Yf@@U?gI46X @@@@@??@e@He@?7YeV1 @? ?
?@f?W.Yg@?eB1 ?@eV/X@e@?@?f@@U?e@@@@@@e@?g?@e@?e@?@?e?@e@?W20Y@?e@?e@?f@?f@?@@@@@@?W20Y@e@?e?@ ?@fV4@@@?eW.Y?f?B1?hB1 @?f?@e@?e@?@@@@@@ @? ?
?@fW.Y?g@?e?@ ?@e?V'@e@?3Lf@V/Xe3Xg@?g?@e@?e@?3LeJ@e@?7<?J@?e@?e@?f@?f@?3Xf?7<?J@e3LeJ@ ?@h@??W.Yh@?h?@ @?f?@e@?e@?3X @? ?
?@f7Yh@?eC5 ?@fN@e@?V/KO.?@?V/X?V/KO.?e@?g?@e@?e@?V/KO&@e@?3=O&@Le@?e@?f@?f@?V/KO.??3=O&@L?V/KO&@ ?@f/K?C5??7Y?f/K?C5?f/KeC5 @?f?@e@?e@?V/KO.? @? ?
?@f@@@@@?f@@@@0Y ?@f?@e@??V40Y?@??V/??V40Y?e@??@f?@e@?e@??V40R'e@?V40MI/e@?e@?f@?f@??V40Y??V40MI/??V40R' ?@fV4@0Y??@@@@@eV4@0Y?fV4@@0Y @?f?@e@?e@??V40Y? @? ?

J5 ?
.Y ?

?
?
?
?
?
?
?
?
?
?

?W2@@6X? ?
?@@@@@@?g?@@?g?@@?fW2@@6X @@he?&0M?@1? ?
?@@?h?@@Lg?@@?e?W&(MI4) @@L?hf?@@? ?
?@@?e?W2@6X?@@@?W2@6X?@@?e?7@HgW2@6X??@@?@@?@@@@6X?@@@?hfJ@5? ?
?@@?e?7@?@1?@@H?&@?@1?@@?e?@@?g7@?@1??@@?@@?@@(Y@1?@@H?he?W&(Y? ?
?@@?e?@@?@@?@@?e@@@@?@@?e?@@?g@@?@@??@@?@@?@@H?@@?@@hfW&(Y ?
?@@?e?@@?@@?@@??7@?@@?@@?e?3@Lg@@?@@??@@?@@?@@??@@?@@he?W&(Y? ?
?@@?e?3@?@5?3@L?3@?@@?@@?e?V')KO2(e3@?@5??3@@@@?@@??@@?3@L?h?7@Y ?
?@@?e?V4@0Y?V4@?V4@@@@@@?fV4@@0YeV4@0Y??V4@@@?@@??@@?V4@?h?@@@@@@? ?

?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?

W&fW2@6X?f@@@@6X ?@@@@6X?e@? ?)X?fW& W&fW2@6X??W2@6Xe?W&? @@@@@??@ ?W&? ?
?W&@f7<?I/?f@?eB1 ?@e?I/X ?@1?f7@ ?W&@f7<?B1??.M?B1eW&@? @? W&@? ?
?.Y@f@?h@?e?@ ?@fN1e@?)T26KO26X??W26X?g?@@Le?J@@eW26Xe)T2@?W26X??@e?@?)T2@@e?@ ?.Y@f@?e@?f?@e.Y@? @?f?@e)T26X??W26X? .Y@? ?
?@f@@@6X?f@?eC5 ?@f?@e@?@(MB@(MB1?W.MI/Xg?@V1e?7Y@?W.MI/X?@(M?W.MI/??@e?@?@(M?@e?@ ?@f@?e@?fJ5f@? @?f?@e@(MB1?W.MI/X @? ?
?@f@??B1?f@@@@@U ?@f?@e@?@He@He@?7YeV1g?@?3L?J5?@?7Y??V1?@He7Hf?@e?@?@H??3L?J5 ?@f3=e@?e?W.Yf@? @@@@@??@e@He@?7YeV1 @? ?
?@f@?e@?f@?eB1 ?@f?@e@?@?e@?e@?@@@@@@g?@?N1?7H?@?@@@@@@?@?e@?f?@e?@?@e?N1?7H ?@fV4@@@?eW.Y?f@? @?f?@e@?e@?@@@@@@ @? ?
?@f@?e@?f@?e?@ ?@fJ5e@?@?e@?e@?3Xhe?@e3T5??@?3X?f@?e3Lf?@eJ@?@f3T5? ?@h@??W.Yg@? @?f?@e@?e@?3X @? ?
?@f3=?C5?f@?eC5 ?@e?O.Ye@?@?e@?e@?V/KO.?g?@eN@H??@?V/KO.e@?eV/KO.??3=O&@?@fN@H? ?@f/K?C5??7Y?g@? @?f?@e@?e@?V/KO.? @? ?
?@fV4@0Y?f@@@@0Y ?@@@@0Y?e@?@?e@?e@??V40Y?e@?e?@e?@e?@eV40Ye@?e?V40Y??V40R'?@fJ5 ?@fV4@0Y??@@@@@f@? @?f?@e@?e@??V40Y? @? ?

?J5? 7H ?
?.Y? ?J5? ?

?.Y? ?
?
?
?
?
?
?
?
?
?
?

W&fW2@6X?f@@@@6X ?@@@@6X?e@? ?)X?fW& W&fW2@6X??W2@6Xe?W&? W2@@6X ?@ ?W&? ?
?W&@f7<?I/?f@?eB1 ?@e?I/X ?@1?f7@ ?W&@f7<?B1??.M?B1eW&@? ?W.MeI/X? ?@ W&@? ?
?.Y@f@?h@?e?@ ?@fN1e@?)T26KO26X??W26X?g?@@Le?J@@eW26Xe)T2@?W26X??@e?@?)T2@@e?@ ?.Y@f@?e@?f?@e.Y@? ?7H?e?V/??W26X?eW26Xe?W26X@ .Y@? ?
?@f@@@6X?f@?eC5 ?@f?@e@?@(MB@(MB1?W.MI/Xg?@V1e?7Y@?W.MI/X?@(M?W.MI/??@e?@?@(M?@e?@ ?@f@?e@?fJ5f@? ?@hW.MI/X?W.MI/X?W.MI'@ @? ?
?@f@??B1?f@@@@@U ?@f?@e@?@He@He@?7YeV1g?@?3L?J5?@?7Y??V1?@He7Hf?@e?@?@H??3L?J5 ?@f3=e@?e?W.Yf@? ?@f@@@?7HeN1?7H??N1?7HeN@ @? ?
?@f@?e@?f@?eB1 ?@f?@e@?@?e@?e@?@@@@@@g?@?N1?7H?@?@@@@@@?@?e@?f?@e?@?@e?N1?7H ?@fV4@@@?eW.Y?f@? ?@g@?@?e?@?@f@?@?e?@ @? ?
?@f@?e@?f@?e?@ ?@fJ5e@?@?e@?e@?3Xhe?@e3T5??@?3X?f@?e3Lf?@eJ@?@f3T5? ?@h@??W.Yg@? ?3L?e?J@?3LeJ5?3L??J5?3LeJ@ @? ?
?@f3=?C5?f@?eC5 ?@e?O.Ye@?@?e@?e@?V/KO.?g?@eN@H??@?V/KO.e@?eV/KO.??3=O&@?@fN@H? ?@f/K?C5??7Y?g@? ?V/KeO&@?V/KO.Y?V/KO.Y?V/KO&@ @? ?
?@fV4@0Y?f@@@@0Y ?@@@@0Y?e@?@?e@?e@??V40Y?e@?e?@e?@e?@eV40Ye@?e?V40Y??V40R'?@fJ5 ?@fV4@0Y??@@@@@f@? V4@@0R'??V40Y?eV40Ye?V40R' @? ?

?J5? 7H ?
?.Y? ?J5? ?

?.Y? ?
?
?
?
?
?
?
?
?
?
?

W&fW2@6X?f@@@@6X ?@@@@6X?e@? ?)X?fW& W&fW2@6X??W2@6XeW2@6X?fW2@@6X @@@@@??@ ?W&? ?
?W&@f7<?I/?f@?eB1 ?@e?I/X ?@1?f7@ ?W&@f7<?B1??.M?B1e.M?B1?f7<eI/ @? W&@? ?
?.Y@f@?h@?e?@ ?@fN1e@?)T26KO26X??W26X?g?@@Le?J@@eW26Xe)T2@?W26X??@e?@?)T2@@e?@ ?.Y@f@?e@?f?@g@?f3= @?f?@e)T26X??W26X? .Y@? ?
?@f@@@6X?f@?eC5 ?@f?@e@?@(MB@(MB1?W.MI/Xg?@V1e?7Y@?W.MI/X?@(M?W.MI/??@e?@?@(M?@e?@ ?@f@?e@?fJ5f?C5?fV46K @?f?@e@(MB1?W.MI/X @? ?
?@f@??B1?f@@@@@U ?@f?@e@?@He@He@?7YeV1g?@?3L?J5?@?7Y??V1?@He7Hf?@e?@?@H??3L?J5 ?@f3=e@?e?W.Yf@@U?gI46X @@@@@??@e@He@?7YeV1 @? ?
?@f@?e@?f@?eB1 ?@f?@e@?@?e@?e@?@@@@@@g?@?N1?7H?@?@@@@@@?@?e@?f?@e?@?@e?N1?7H ?@fV4@@@?eW.Y?f?B1?hB1 @?f?@e@?e@?@@@@@@ @? ?
?@f@?e@?f@?e?@ ?@fJ5e@?@?e@?e@?3Xhe?@e3T5??@?3X?f@?e3Lf?@eJ@?@f3T5? ?@h@??W.Yh@?h?@ @?f?@e@?e@?3X @? ?
?@f3=?C5?f@?eC5 ?@e?O.Ye@?@?e@?e@?V/KO.?g?@eN@H??@?V/KO.e@?eV/KO.??3=O&@?@fN@H? ?@f/K?C5??7Y?f/K?C5?f/KeC5 @?f?@e@?e@?V/KO.? @? ?
?@fV4@0Y?f@@@@0Y ?@@@@0Y?e@?@?e@?e@??V40Y?e@?e?@e?@e?@eV40Ye@?e?V40Y??V40R'?@fJ5 ?@fV4@0Y??@@@@@eV4@0Y?fV4@@0Y @?f?@e@?e@??V40Y? @? ?

?J5? 7H ?
?.Y? ?J5? ?

?.Y? ?
?
?
?
?
?
?
?
?
?
?

W&fW2@6X?f@@@@6X ?@@@@6X?e@? ?)X?fW& W&fW2@6X??W2@6XfW&g@@@@6X @@@@@??@ ?W&? ?
?W&@f7<?I/?f@?eB1 ?@e?I/X ?@1?f7@ ?W&@f7<?B1??.M?B1e?W&@g@?eI/X? @? W&@? ?
?.Y@f@?h@?e?@ ?@fN1e@?)T26KO26X??W26X?g?@@Le?J@@eW26Xe)T2@?W26X??@e?@?)T2@@e?@ ?.Y@f@?e@?f?@eW.Y@g@?e?N1? @?f?@e)T26X??W26X? .Y@? ?
?@f@@@6X?f@?eC5 ?@f?@e@?@(MB@(MB1?W.MI/Xg?@V1e?7Y@?W.MI/X?@(M?W.MI/??@e?@?@(M?@e?@ ?@f@?e@?fJ5?W.Y?@g@?f@? @?f?@e@(MB1?W.MI/X @? ?
?@f@??B1?f@@@@@U ?@f?@e@?@He@He@?7YeV1g?@?3L?J5?@?7Y??V1?@He7Hf?@e?@?@H??3L?J5 ?@f3=e@?e?W.Y?7Y??@L?f@?f@? @@@@@??@e@He@?7YeV1 @? ?
?@f@?e@?f@?eB1 ?@f?@e@?@?e@?e@?@@@@@@g?@?N1?7H?@?@@@@@@?@?e@?f?@e?@?@e?N1?7H ?@fV4@@@?eW.Y??@@@@@@?f@?f@? @?f?@e@?e@?@@@@@@ @? ?
?@f@?e@?f@?e?@ ?@fJ5e@?@?e@?e@?3Xhe?@e3T5??@?3X?f@?e3Lf?@eJ@?@f3T5? ?@h@??W.Yg?@H?f@?e?J5? @?f?@e@?e@?3X @? ?
?@f3=?C5?f@?eC5 ?@e?O.Ye@?@?e@?e@?V/KO.?g?@eN@H??@?V/KO.e@?eV/KO.??3=O&@?@fN@H? ?@f/K?C5??7Y?g?@g@?eO.Y? @?f?@e@?e@?V/KO.? @? ?
?@fV4@0Y?f@@@@0Y ?@@@@0Y?e@?@?e@?e@??V40Y?e@?e?@e?@e?@eV40Ye@?e?V40Y??V40R'?@fJ5 ?@fV4@0Y??@@@@@f?@g@@@@0Y @?f?@e@?e@??V40Y? @? ?

?J5? 7H ?
?.Y? ?J5? ?

?.Y? ?
?
?
?
?
?
?
?
?
?
?

W&fW2@6X?f@@@@6X ?@@@@6X?e@? ?)X?fW& W&fW2@6X??W2@6Xe@@@@@?f@@@@6X @@@@@??@ ?W&? ?
?W&@f7<?I/?f@?eB1 ?@e?I/X ?@1?f7@ ?W&@f7<?B1??.M?B1g@?f@?eI/X? @? W&@? ?
?.Y@f@?h@?e?@ ?@fN1e@?)T26KO26X??W26X?g?@@Le?J@@eW26Xe)T2@?W26X??@e?@?)T2@@e?@ ?.Y@f@?e@?f?@f?J5?f@?e?N1? @?f?@e)T26X??W26X? .Y@? ?
?@f@@@6X?f@?eC5 ?@f?@e@?@(MB@(MB1?W.MI/Xg?@V1e?7Y@?W.MI/X?@(M?W.MI/??@e?@?@(M?@e?@ ?@f@?e@?fJ5f?7H?f@?f@? @?f?@e@(MB1?W.MI/X @? ?
?@f@??B1?f@@@@@U ?@f?@e@?@He@He@?7YeV1g?@?3L?J5?@?7Y??V1?@He7Hf?@e?@?@H??3L?J5 ?@f3=e@?e?W.Yf?@g@?f@? @@@@@??@e@He@?7YeV1 @? ?
?@f@?e@?f@?eB1 ?@f?@e@?@?e@?e@?@@@@@@g?@?N1?7H?@?@@@@@@?@?e@?f?@e?@?@e?N1?7H ?@fV4@@@?eW.Y?fJ5g@?f@? @?f?@e@?e@?@@@@@@ @? ?
?@f@?e@?f@?e?@ ?@fJ5e@?@?e@?e@?3Xhe?@e3T5??@?3X?f@?e3Lf?@eJ@?@f3T5? ?@h@??W.Yg7Hg@?e?J5? @?f?@e@?e@?3X @? ?
?@f3=?C5?f@?eC5 ?@e?O.Ye@?@?e@?e@?V/KO.?g?@eN@H??@?V/KO.e@?eV/KO.??3=O&@?@fN@H? ?@f/K?C5??7Y?g@?g@?eO.Y? @?f?@e@?e@?V/KO.? @? ?
?@fV4@0Y?f@@@@0Y ?@@@@0Y?e@?@?e@?e@??V40Y?e@?e?@e?@e?@eV40Ye@?e?V40Y??V40R'?@fJ5 ?@fV4@0Y??@@@@@f@?g@@@@0Y @?f?@e@?e@??V40Y? @? ?

?J5? 7H ?
?.Y? ?J5? ?

?.Y? ?
?
?
?
?
?
?
?
?
?
?

W&fW2@6X?f@@@@6X ?@@@@6X?e@? ?)X?fW& W&fW2@6X??W2@6XeW2@6X?f@@@@6X W2@@6X ?@ ?W&? ?
?W&@f7<?I/?f@?eB1 ?@e?I/X ?@1?f7@ ?W&@f7<?B1??.M?B1e7<?B1?f@?eI/X? ?W.MeI/X? ?@ W&@? ?
?.Y@f@?h@?e?@ ?@fN1e@?)T26KO26X??W26X?g?@@Le?J@@eW26Xe)T2@?W26X??@e?@?)T2@@e?@ ?.Y@f@?e@?f?@e@?e@?f@?e?N1? ?7H?e?V/??W26X?eW26Xe?W26X@ .Y@? ?
?@f@@@6X?f@?eC5 ?@f?@e@?@(MB@(MB1?W.MI/Xg?@V1e?7Y@?W.MI/X?@(M?W.MI/??@e?@?@(M?@e?@ ?@f@?e@?fJ5e@?e@?f@?f@? ?@hW.MI/X?W.MI/X?W.MI'@ @? ?
?@f@??B1?f@@@@@U ?@f?@e@?@He@He@?7YeV1g?@?3L?J5?@?7Y??V1?@He7Hf?@e?@?@H??3L?J5 ?@f3=e@?e?W.Ye3=e@?f@?f@? ?@f@@@?7HeN1?7H??N1?7HeN@ @? ?
?@f@?e@?f@?eB1 ?@f?@e@?@?e@?e@?@@@@@@g?@?N1?7H?@?@@@@@@?@?e@?f?@e?@?@e?N1?7H ?@fV4@@@?eW.Y?eV4@@@?f@?f@? ?@g@?@?e?@?@f@?@?e?@ @? ?
?@f@?e@?f@?e?@ ?@fJ5e@?@?e@?e@?3Xhe?@e3T5??@?3X?f@?e3Lf?@eJ@?@f3T5? ?@h@??W.Yh@?f@?e?J5? ?3L?e?J@?3LeJ5?3L??J5?3LeJ@ @? ?
?@f3=?C5?f@?eC5 ?@e?O.Ye@?@?e@?e@?V/KO.?g?@eN@H??@?V/KO.e@?eV/KO.??3=O&@?@fN@H? ?@f/K?C5??7Y?f/K?C5?f@?eO.Y? ?V/KeO&@?V/KO.Y?V/KO.Y?V/KO&@ @? ?
?@fV4@0Y?f@@@@0Y ?@@@@0Y?e@?@?e@?e@??V40Y?e@?e?@e?@e?@eV40Ye@?e?V40Y??V40R'?@fJ5 ?@fV4@0Y??@@@@@eV4@0Y?f@@@@0Y V4@@0R'??V40Y?eV40Ye?V40R' @? ?

?J5? 7H ?
?.Y? ?J5? ?

?.Y? ?
?
?
?
?
?
?
?
?
?

?W2@@6X? ?
?@@@@@@?g?@@?g?@@?fW2@@6X @@he?7@?I4)? ?
?@@?h?@@Lg?@@?e?W&(MI4) @@L?h?@@? ?
?@@?e?W2@6X?@@@?W2@6X?@@?e?7@HgW2@6X??@@?@@?@@@@6X?@@@?h?@@@@6X? ?
?@@?e?7@?@1?@@H?&@?@1?@@?e?@@?g7@?@1??@@?@@?@@(Y@1?@@H?h?@@??@1? ?
?@@?e?@@?@@?@@?e@@@@?@@?e?@@?g@@?@@??@@?@@?@@H?@@?@@he?@@??@@? ?
?@@?e?@@?@@?@@??7@?@@?@@?e?3@Lg@@?@@??@@?@@?@@??@@?@@he?@@??@@? ?
?@@?e?3@?@5?3@L?3@?@@?@@?e?V')KO2(e3@?@5??3@@@@?@@??@@?3@L?h?3@??@5? ?
?@@?e?V4@0Y?V4@?V4@@@@@@?fV4@@0YeV4@0Y??V4@@@?@@??@@?V4@?h?V4@@0Y? ?

?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?
?

Figure 2: Database Tool Palette
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Works, open the “Coin Collection.DB” data-
base on the CD, and work along with this
tutorial.

Stage I: Creating the Layout

You will start by creating the layout for the
Coin Case Directory report in Figure 1. Fol-
low these steps:

1. Click on the Layout Button on the Tool
Palette and select “New Layout” (see
Figure 3).

2. With the New Layout Dialog Box on the
screen, select “Columnar Report”. Name
the layout “Coin Case Directory”, and
click on “OK” (see Figure 4). Apple-
Works will display the Set Field Order
Window (see Figure 5).

Now you will choose the fields you want to
print in the report and the order in which
they will appear across the top of the page.

3. Click on the Coin Case # field name in
the Field List, then click on “Move” to
put that field in the Field Order Window.

4. Repeat this process for the Coin Type,
Year/Mint, Condition, and Count fields.
Then click on “OK”. The columnar lay-
out that appears will look like the exam-
ple in Figure 6. 

5. Select “Layout” from the Layout Menu.
Your screen will look like the example in
Figure 7. The field names appear as
labels in the Header Section at the top
of the page. The Body Section shows
where AppleWorks will print each row of
data.

Now you will use the Arrow Tool to adjust
the size and location of the fields and field
labels.

6. Click on the Coin Case # field (not the
field label) to select that field. “Handles”
will appear at the corners of the field
box.

Figure 3: Creating a New Layout

Figure 4: New Layout Dialog Box

Figure 5: Selecting Fields for the Report 

Figure 6: Unenhanced Columnar Layout 
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7. Click on the lower-right handle, hold
down the mouse button, and drag the
mouse to the left to reduce the size of
the box. Re-size the field so it looks like
the example in Figure 7.

8. Next, you will re-position the Coin Type
field and its associated label. Click in the
center of the Coin Type field, then hold
down the Shift Key and click on the
Coin Type label in the Header Section at
the top of the screen. That selects both
the field and the associated label.

Release the Shift Key and the mouse
button. Then press the Left Arrow Key
eight times to move both objects into
the position shown in Figure 7. Then
click elsewhere on the layout to de-
select these objects.

9. Re-size the Coin Type field by clicking
and dragging the lower-right handle to the
right.

10.Re-size and re-position the remaining fields and
labels so your screen looks like the example in
Figure 7. Owners of small monitors will have to
scroll to the right to re-size and move the
Count field and its associated label.

11.Select Browse Mode (Shift- -B) and check
that you allocated enough space to each field
and to the space between the rows of data. The
space between the row of fields and the Body
Line determines the amount of space between
the rows of data in your report. You can adjust
this space by moving the Body Box up or down
on the layout. Experiment with different set-
tings. Press Shift- -B to display the results of
your changes and Shift- -L to return to Lay-
out Mode.

12.If your layout does not display all the data,
press Shift- -L to return to the Layout Mode,
and modify the layout. Then repeat step #11. 

Adding Summaries

Now you will add a “Sub-Summary” section to
your layout. [Ed: AppleWorks prints the Sub-sum-

mary section after each set of records. You will
define those “sets” in step #2 below.]This sum-
mary will count and report the number of coins in
each coin book or case. 

1. Go to the Layout Menu and select “Layout” (or
press Shift- -L). Then select “Insert Part”
from the Layout Menu.

2. AppleWorks selects “Sub-Summary when sorted
by…”. Click on “Coin Case #” and click on
“OK” (see Figure 8). That tells AppleWorks to
print a sub-summary section each time it
switches to the next coin case number.

Figure 7: Fields Re-Sized and Re-Positioned
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Figure 8: Insert Part Dialog Box 

Field Label

Figure 9: Adding the “Total Count” Summary Field
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3. Sub-Summary sections can appear above or
below the body of the report. Click on “Below”.
The layout will re-appear with the Sub-Sum-
mary section below the Body section.

Next, you will insert the Total Count summary
field that will display the total number of coins in
each coin case.

4. Go to the Layout Menu and select “Insert
Field”.

5. Select “Total Count” from the Insert Field
Window and click on “Insert” (see Figure 9).
The Total Count field and its associated label
will appear in the body of the layout.

6. Select both the Total Count field and field
label by holding down the Shift Key as you
click on the field and its associated label. Then
release the Shift Key, click on either the Total
Count field or its label, and re-position the two
objects in the Sub-Summary area (see Figure
10). [Ed: You can also use the Arrow Keys to
move the objects into their final positions.]

7. Click and drag the Body Line to adjust the
spacing so it matches Figure 10.

8. Select Browse Mode (Shift- -B) to see the
effects of your changes. [Ed: The Total Count
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field will not appear on your screen
until you sort your data in Stage III
below.] If necessary, return to Layout
Mode (Shift- -L) and adjust your lay-
out. 

9. That completes the report layout. Press
-S to save your work.

Stage II: Selecting Records

Your next task is to select the records for your
report. Your sample report will include all the
records in the file, so you will not enter record
selection criteria in this tutorial. But here are the
steps to follow when you select records for other
reports [Ed: See the article entitled “How to
Locate Specific Records” on AWUG’s AppleWorks
Journal CD Compendium – Vol. 1 for help using
AppleWorks’ Find Command.]

1. Click on the Select Records Button on the
Tool Palette and choose “New Search” (see
Figure 11).

2. Enter a name such as “Pennies” for the search.
Enter a search name that will help you remem-
ber the selection criteria established for that
search.

3. Click on the field(s) you want to include in the
search and enter the search criteria. Then click
on “Store”.

4. Click on the Select Records Button and select
the search name from the pop-up menu. Apple-
Works will select the records you specified in
step #3 above. Select “Show All Records” from
the Organize Menu to display all the data in
your file.

Stage III: Defining a Sort

Next, you will define the rules you will use to sort
the records in the report. You want your Coin Case
Directory to list the records by Coin Case #. Then,
within each case, you want to list the coins by Coin
Type, and finally, within each Coin Type, by
Year/Mint (see Figure 1).

Follow these steps to define the sort:

1. Press Shift- -B to enter Browse Mode.

Figure 10: Sub-Summary Area and Summary Field in Place
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Figure 11: Defining a Search



you will want to print the report instead of just
viewing the results on the screen.

6. Click on “OK” to save the settings.

Now you can print the report. Just click on the
Report Button on the Tool Palette and select “Coin
Case Directory”. AppleWorks will switch to the
correct layout, sort your data, and print the report.

Conclusion

Well, you’ve done it. You created your first report.
As you saw, the process involves more than two
dozen steps, but each step is easily “do-able”. And
the overall process flows in a logical, sequential
order guided by the four buttons on AppleWorks’
database Tool Palette.

Since AppleWorks saves your report specifications,
printing each report is as simple as selecting the
saved report from the database Tool Palette. ■

Database Primer
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2. Click on the Sort Records Button on the
Tool Palette and choose “New Sort”.
AppleWorks will display the Sort
Records Dialog Box in Figure 12.

3. Name the sort “Coin Case Directory”. 

4. Select “Coin Case #” in the left window
and click on the Move Button. The
default sorting order is “ascending”, and
since you want the coin cases listed in
ascending order (that is, from 1 to 10),
accept this AppleWorks default. 

5. Select “Coin Type” and click on the
Move Button. Then select “Year/Mint” and
click on “Move”. Once again, ascending order
is appropriate. Your screen should look like the
example in Figure 12.

6. Click on “OK” to define the sort.

7. Now you will sort the data. Click on the Sort
Records Button in the Tool Palette and select
“Coin Case Directory” from the menu. Apple-
Works will sort the coins by their case number,
by coin type, and then by year minted within
each coin type.

8. Now you can see the effects of your changes.
Press Shift- -P (or select “Page View” from
the Window Menu) to display the report in
Figure 1.

9. Press -S to save your work.

Stage IV: Saving the Report

Finally, you will save the report layout, search, and
sort criteria so you can print the report with a sin-
gle mouse-click. Follow these steps to save your
report format:

1. Click on the Report Button on the Tool Palette
and choose “New Report” (see Figure 13).

2. Name the report “Coin Case Directory”. 

3. Select “Coin Case Directory” from the Layout
pop-up menu.

4. Select “Coin Case Directory” from the Sort
pop-up menu.

5. Click on “Print Report”. That tells AppleWorks
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Figure 12: Sort Records Dialog Box

Figure 13: New Report Dialog Box



TIME VALUE MATERIAL

Special Sample Issue

Name __________________________________________

Member Nº, if renewing ___________________________

Address ________________________________________

_______________________________________________

City __________________ State _______ Zip ________

Country __________ Email _______________________

Daytime Phone __________________________________

The AppleWorks Journal— 1 year (10 issues), shipped as follows:

One Two1

Circle One: Year Years

Periodical postage - United States $39 $74
Electronic Delivery via email 34 64
Periodical postage - Canada and Mexico 49 94
1st Class postage - United States 55 106
1st Class airmail - Canada and Mexico 61 118
Surface mail outside North America 53 102
Airmail outside North America 76 148

n Unlimited Web downloads @ $10 additional per year.

n Check  n MC/Visa  n PO # 2 ____________________

Credit Card Account # ____________________________

Expiration Date _________________________________

Signature _______________________________________

1 Includes a $4 discount and avoids future price increases. 
2 Payment must accompany all purchase orders.

AWUG shares members’ addresses with other user groups and selected vendors. If you
do not want to receive mail from these agencies, check here. n

AppleWorks and the AppleWorks logos are registered trademarks of Apple Computer, Inc.
AWUG and the AWUG logo are trademarks of the AppleWorks Users Group International.
The AppleWorks Users Group is an independent organization and is not affiliated with
Apple Computer, Inc.

AWUG Membership About AWUG
A subscription to the AppleWorks Journalincludes a one-
year membership in the AppleWorks Users Group.

The AppleWorks Users Group (AWUG) is an independent
support group dedicated to helping AppleWorks users.
Formed in 1991, AWUG is the world’s largest user group
with more than 15,000 AppleWorks-using members in the
United States and 51 other countries.

AWUG member benefits include unlimited technical sup-
port from our 76 member-volunteers, complete access to
AWUG’s Public Domain Library with thousands of activi-
ties, templates, clip-art, and other enhancements that work
with AppleWorks, access to AWUG’s Web site and instruc-
tional videotape library, and the dozens of special discounts
that we negotiate for our members.

AppleWorks Users Group
Box 701010; Plymouth, MI 48170

(734) 454-1969  Fax: (734) 454-1965
Internet: http://www.awug.org

AppleWorks Journal

A p p l e W o r k s  U s e r s  G r o u p 


Periodical
Postage

Paid at 
Plymouth, MI

and other Offices

You can reach AWUG by mail, telephone, fax, and on the
World Wide Web. Our mailing address, telephone, fax num-
ber, and Web address appear in the mailing panel below.
Here are our email addresses:

Member Services: membership@awug.org

Orders: orders@awug.org

Editor: editor@awug.org

Webmaster: webmaster@awug.org

How to Contact AWUG




AWUG

App
leWorks Users

Group International


